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Lunar Map Pro, now in its fourth release, is described by its publisher as “the most 
advanced, highest resolution lunar application ever developed for Windows.” Most users 
will, no doubt, agree with this assessment even though this description seems inadequate 
after using the program within the context of a lunar observing campaign. 
 
The software ships on a single CD-ROM housed in a plastic case of the type used for 
DVD movies. No printed documentation is supplied; however a Quick Start Guide and a 
User’s Manual are contained on the disc. Both documents, in PDF format, are accessible 
from within the application. Adobe Acrobat Reader v5.05 is also furnished on the CD. 
Documentation is also available on the RITI website. 
 

Recommended System Requirements 
1 GHz CPU (1.5 GHz for 3D / high-resolution geology) 

256 MB RAM (512 MB for high-resolution geology) 
110 MB  for compact installation – 370 MB for complete installation 

1024 x 768 monitor resolution 
16 MB video RAM 

Microsoft Windows 2000 or XP 
$89.95  ($39.95 upgrade from version 2.0 or $49.95 upgrade from versions 1.0 or 1.5) 
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While Lunar Map Pro provides sophisticated features and functionality that will satisfy 
the most experienced lunar observers, it does not do so at the expense of those new to 
viewing our closest celestial neighbor. 
 
The software installation is quick and easy. The user is prompted for the desired 
installation directory, the program group in which to locate the application’s icons and 
the level of install - ranging from a compact 110 MB to a complete 370 MB. Given the 
cost of hard drive space these days and the nature of this application; I don’t see any 
reason not to perform a complete install. A desktop shortcut is also created. 
 
RITI employs copy protection that requires the user to insert the CD each time the 
application is launched. The disc can be removed once the program starts. RITI grants the 
user permission to install the software on as many PCs as desired. An optional procedure 
can be employed to obtain a license string that negates having to insert the CD, if so 
desired.  
 
Once the installation is finished and the application is launched, the CD can be removed 
from the drive (if a complete install was performed). When the program opens, the user is 
greeted by a raster map of the lunar nearside (created from NASA Clementine data) with 
orange-colored overlaying latitude and longitude lines (zero latitude and longitude lines 
are blue). The grid can be toggled on or off, and it dynamically adjusts to the 
magnification level of the map. Also displayed on the initial screen is a smaller 
navigational window. The content of this window is a small vector map of the lunar disc, 
with an inset rectangle indicating the area being displayed on the main map – a very 
handy feature that can be dragged anywhere on the screen, minimized or closed. It is 
updated whenever the main map changes. Navigational tools can be used on either map. 
 
Like most astronomy software, Lunar Map Pro retains the general structure and 
appearance of any Windows application. There are menu headings horizontally placed 
above a toolbar at the top of the screen and a status bar along the bottom. Both the toolbar 
and status bar can be toggled on and off. The toolbar is pre-configured with what the 
publisher considers to be the most used features, but it is not customizable. The menu 
headings include: File, View, Zoom, Pan, Help, Tools and Lunar, with appropriate sub-
menus below. The status bar displays the latitude and longitude relative to your cursor 
position on the map in addition to the scale of the map. 
 
The program boasts an impressive database of 8,169 named features. 
 

1,561 primary craters 34 mountain peaks 
5,853 associated lettered craters 19 mountain ranges 

26 large plains 11 capes 
35 small plains 269 fissures 
20 crater chains 9 scarps 

158 domes or volcanic peaks 33 valleys 
40 ridges 79 features named by Apollo astronauts 
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The main lunar map is corrected for libration, ensuring an accurate depiction of the 
Moon. The default display is North Up, matching naked-eye or binocular views. It is also 
configurable as North Up Reversed (SCT or MCT view), South Up (Newtonian) or South 
Up Reversed (southern hemisphere SCT) – ensuring every lunar observer is 
accommodated with a display matching that of their telescope.  
 
The map can be further configured to show vector feature outlines, with or without the 
raster image. This is especially useful in identifying difficult features both on-screen and 
on the printed charts. Mare can also be displayed using vector polygons. And if that 
wasn’t enough, you can also display color-coded geological data classifying features by 
type, age and system. This flexibility is sure to provide a map appropriate to most any 
observational activity. 
 

 
Raster map of Atlas & Hercules 

 

 
Vector outline map of Atlas & Hercules 

 

 
Combined raster and vector outline map 
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In addition to the searching tool, features can be identified by hovering over them with 
the cursor. Once identified a right-click provides biographical data. 
 
The File menu provides the functionality to redraw the map on-screen, as well as to write 
the map to a file or send it straight to the printer. 
 
In the View menu, the user can toggle the toolbar, status bar and compass. The compass is 
a very handy feature when working with magnified maps, allowing the user to keep their 
bearings. The new 3D feature is also activated from within this menu. This feature is 
based on lunar radar data combined with a GIS platform to render some very interesting 
views. 
 

 
3D view of Theophilus and surrounding area 

 
The user has control over point-of-view, magnification and orientation in 3D views. 
The Zoom menu provides control over map magnification. Personally, I find it easier to 
use the toolbar for this activity. From here you can zoom in or out in 50% increments and 
quickly return to the full lunar disc map. You can also enable zooming by way of a 
rectangle dragged across the map with your cursor – this being the most useful feature in 
the menu for my use. A scaling tool allows you to precisely scale your map, if your 
project calls for such precision. 
 
The Help menu provides the expected functionality plus some unexpected features: a 
glossary, a list of label abbreviations, a lunar fact sheet, a legend for the color-coded 
geology markings, and a table for locating the objects in Charles Woods’ Lunar 100 
observing list. 
 
The Pan menu is home to navigational commands such as stepping (in 25% increments) 
to the north, south, east or west. You can also enable the dragging of the map. The mouse 
can be used to center a clicked-on feature. And a feature can be centered by entering its 
coordinates. 
 
Within the Tool menu the user can access the labeling feature. While this is quite 
extensive and customizable to a great degree, I would like to see additional flexibility 
allowing users to apply whatever level of labeling they require on maps or saved files. 
The labeling is executed by entire groups of features, which can’t be edited. So, if you 
check the Craters box, all craters visible in your map will be labeled. This can be quite 
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useful, but there will also be projects which just require the ability to selectively label 
features. Font size and color can be adjusted to suit the intended use of the map. 
 

 
The Labeling dialog box 

 
The Surveyor tool is accessed from within this menu, and it allows the user to make 
accurate lunar measurements. While most data regarding individual features is readily 
available, this tool allows for measurements limited only by your imagination. The 
geographic information system (GIS) upon which Lunar Map Pro is built takes into 
consideration the difference between the flat, displayed image and the actual curvature of 
the Moon. The result is a surprisingly accurate measurement system. You can measure 
between any number of points, so curved or irregular shapes aren’t excluded. The user 
guide indicates that an enhanced level of accuracy is obtained when using higher map 
magnifications. A useful tool that’s fun to use too! I found that accuracy can be further 
increased by turning on the vector outlines in the map. 
 
A Night View tool is available, but I don’t find it to be particularly useful. It allows the 
user to dim the screen, while keeping the toolbar buttons at full brightness. Since dark 
adaptation isn’t really necessary when observing Luna, at least not for me, I don’t see a 
need for such a feature. If I want to dim the screen, I normally just use that functionality 
provided by my laptop. Maybe you will find it useful. 
 
The Resource Viewer tool provides a link to tons of online lunar information, right from 
within the application. A very nice feature when you are using the program indoors, or if 
you are so lucky as to have an internet connection at the telescope. 
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The Lunar menu is home to some of the most useful features in the program. From here 
you can control the mapping properties, the time, phases, search for specific features, 
toggle the grid, adjust the field of view, create an ephemeris, display landing sites and 
change your point of view. 
 
The Time, Phases and Ephemeris features all work together dynamically. The time can be 
either your local time or universal time. Within the Phases tool, the opacity of the portion 
of the lunar disc in darkness can be varied, thereby allowing the user to still discern 
features beyond the terminator. When the Time tool is open, the map is not updated 
automatically – the user must click a button labeled Current to update the map. The 
Phase Manager shows one lunation, and is an excellent tool to help the user understand 
the lunar cycle graphically. It can also be employed to manually adjust the map to lunar 
cycles other than the current lunation. This is very useful for planning purposes, or to 
review past observing sessions… so long as the dates are between January 1, 1970 and 
December 31, 2100. 
 
Working with the Ephemeris tool requires that the user input the latitude and longitude of 
their observing site. 
 
The Field of View tool is one of my favorite features of the entire program. This nifty tool 
allows for the creation of custom maps – displayed or printed – that correspond to the 
view through your telescope. Naturally, you have to first configure the application with 
the focal lengths of your telescopes, and with the focal lengths and apparent field of view 
for your oculars.  A very powerful observational tool is at your fingers when this tool is 
combined with phase display and proper map orientation. 
 

 
Atlas and Hercules in a FOV map specific to my Intes MK66 and Barlowed 7mm UO HD 

Orthoscopic 
 

The Point of View tool is not about personal opinion… rather it allows you to change 
your view of the Moon by aligning yourself at different points in space. Another one of 
those features that is fun to play with. 
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The Feature Finder makes easy work of locating any feature in Lunar Map Pro’s vast 
database. Once the feature is located you can employ other observational tools such as 
the sunrise and sunset gazetteer. A click of the mouse lets you know the dates and times 
for the next sunrise and sunset for that feature – what a useful planning feature that is! 
Another useful feature of this tool is the ability to link your own images, sketches and 
observing notes to any feature in the database. How cool is that? 
 
And yet another useful feature of this tool is to selectively apply labels. Unlike the 
labeling feature discussed earlier, this is where you have almost complete labeling 
control. Almost? Yes, you are limited in where the application places the label. It seems 
that the label has to touch the feature, while it would be nice to be able to drag the label 
into just the right position. 
 
The 3D Viewer tool is new in this version of the software. It allows the user to create 
maps which depict the lunar topography. The adjustable parameters include point of 
view, magnification, orientation, relief exaggeration and visual appearance. 
 
Two resolution levels can be employed, with the higher level using a display twice the 
size of the lower resolution, with twice the data. The Point of View is adjustable in 25% 
increments to the north, south, east or west. You can zoom in or out by a factor of two. 
Rotation is adjustable in 10° increments up, down, left or right. The Relief Exaggeration 
applies a multiplier to all surface elevations, and thereby makes it easier to see subtle 
features. The Visual Appearance can either be photo-realistic or in the form of a wire 
mesh. Alternating between the two allows the user to fully comprehend the topography of 
the feature under study. 
 
I started using Lunar Map Pro with version 2.0, and just recently upgraded to version 3.0. 
I am constantly seeking to enhance my lunar observation skills, and this program has 
greatly facilitated that endeavor. I would unequivocally recommend this program to 
anyone with a serious interest in lunar studies, whether the studies involve visual 
observation, lunar photography, or just armchair observing. 
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